
 

To our customers, 
 

Old Company Name in Catalogs and Other Documents 

 
On April 1st, 2010, NEC Electronics Corporation merged with Renesas Technology 

Corporation, and Renesas Electronics Corporation took over all the business of both 
companies. Therefore, although the old company name remains in this document, it is a valid 
Renesas Electronics document. We appreciate your understanding. 
 

Renesas Electronics website: http://www.renesas.com 
 
 
 
 

April 1st, 2010 
Renesas Electronics Corporation 

 
 
 
 
 
Issued by: Renesas Electronics Corporation (http://www.renesas.com) 

Send any inquiries to http://www.renesas.com/inquiry. 

 



Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights 
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights 
of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. 
4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
laws and regulations and follow the procedures required by such laws and regulations.  You should not use Renesas 
Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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SH7080-Series E200F Emulator 
Performance Measurement 

Overview 
The E200F emulator provides two functions to analyze the performance of user programs: on-chip 

performance analysis and AUD performance analysis. This document describes how to use the E200F 
emulator for the SH7080 in on-chip performance measurement. 

The examples given in this document are of E200F-emulator usage in a stand-alone form. The functions 
described in this document are also available on all E200F emulators, regardless of the target device in use. 
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1. Specifications 
The on-chip performance analysis function applies a counter in the device to measure the number of 

cycles from one specified condition being satisfied until another specified condition is subsequently satisfied. 
According to the supported device that is in use, various other items such as the number of cache misses 
and TLB misses may also be measurable. The on-chip performance analysis function cannot be used when 
the profiling function is enabled. 

The AUD performance analysis function allows the user to measure times or numbers of instructions 
executed between specified events in the AUD event-detection system. The resolution of the timer can be 
set to 20 ns, 100 ns, 400 ns, or 1.6 μs. At 20 ns, the maximum time that can be measured is about six hours, 
and at 1.6 μs, the maximum time is about 20 days. 

 

2. Functional Descriptions 
This document explains how to analyze the performance by using the sample program included in the 

package that can be downloaded from the Renesas website. 

The version of the tool is as follows: 

Emulator Software: 

E200F Emulator Debugger Version 2.04.00 

 

3. Software Preparation 

3.1 Introduction 
Install the software provided in the CD-ROM of the E200F emulator to expand the sample program 

(tutorial workspace) to be used with this document on your personal computer. 

The software in the CD-ROM of the E200F emulator can also be installed on a personal computer in which 
the High-performance Embedded Workshop has already been installed. In this case, some dialog boxes 
may be skipped in the installation process. 

 

3.2 Installing the E200F Emulator Software 
Execute HewInstMan.exe from the CD-ROM of the E200F emulator. 

For details on installation, refer to the introductory guide for the E200F emulator on the Renesas website 
and follow the directions shown on the screen during installation. The full installation procedure is not 
described here. 

 

3.3 Auto-Update Utility 
When the auto-update utility is selected upon installation of software, it is possible to check the latest 

version of tools on the Internet. 
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4. Operations 
This section explains how to activate the High-performance Embedded Workshop (HEW) and how to 

analyze the performance in the following steps. 

 

Analyzing performance by measuring the number of executed instructions 

Analyzing performance by setting data conditions (eventpoints) 

Activating the HEW 

END 

Analyzing performance by using eventpoints 

Opening a workspace 

START  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.1  Procedures for Sample Program Execution 

 

4.1 Activating the High-performance Embedded Workshop 
First, connect the E200F emulator with the user system to the host computer via the USB cable and check 

that debugging is enabled. 

Next, activate the High-performance Embedded Workshop by opening the [Start] menu and selecting [All 
Programs], [Renesas], [High-performance Embedded Workshop], and [High-performance Embedded 
Workshop], in that order. 
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4.2 Opening a Workspace 
(1) The [Welcome!] dialog box will appear on the High-performance Embedded Workshop screen. 

 

 

Select the [Browse to another project workspace] radio button in the [Welcome!] dialog box and click on 
the [OK] button. 
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(2) The [Open Workspace] dialog box will appear. 

  

When the software from the CD-ROM of this product has been installed, workspace “Tutorial.hws” is 
stored in the folder structure shown below (standard location). Specify the correct location by opening 
the folders in order. Select the workspace “Tutorial.hws” and click on the [Open] button. 
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Note: The above directory may not be specifiable depending on the software version. In this case, 
select the following directory. 

 

<High-performance Embedded Workshop installation directory> 

¥Tools¥Renesas¥DebugComp¥Platform¥E200F¥SH7080Series¥Tutorial_SH7080Series 

Directory examples: 

C:¥hew3¥Tools¥Renesas¥DebugComp¥Platform¥E200F¥ SH7080Series¥Tutorial_SH7080Series 

C:¥hew2¥Tools¥Renesas¥DebugComp¥Platform¥E200F¥ SH7080Series¥Tutorial_SH7080Series 

 

(3) f the workspace version is not the latest available, the following dialog box will appear. To update to the 
new version, click on the [OK] button. 

  

C:¥WorkSpace 
  └Tutorial 
    └E200F 
      └SH7080Series 
        └Tutorial_SH7080Series 
          └Tutorial.hws 

C:¥WorkSpace¥Tutorial¥E200F¥SH7080Series¥Tutorial_SH7080Series¥Tutorial.hws 
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(4) A [Warning] dialog box appears. To open the workspace, which is now stored in a different directory, 
click on the [OK] button. 

 

 

(5) If the [Toolchain missing] dialog box appears, select the target project name and click on the [OK] 
button. 

 

 

(6) If the [Changing Toolchain Version] dialog box appears, select the desired toolchain version and click on 
the [OK] button. 
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(7) If the [Change Toolchain Version Summary] dialog box appears, just click on the [OK] button. 

 

 

(8) Once the workspace is opened, the [Select Emulator mode] dialog box appears. Select the MCU in use 
from [Device]. Then select [E200 Emulator] for [Mode] and click on the [OK] button. 

 

[R5E70865R] is selected in this example. 

 

(9) The [Function select] dialog box appears. Click on the [OK] button to accept the default settings. 
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(10) The [Select Emulation] dialog box appears. Click on the [OK] button to accept the default settings. 

 

 

(11) The [ID Code] dialog box appears. Click on the [OK] button to accept the default setting, [E200F]. 
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(12) While the E200F emulator is being connected, the [Connecting] dialog box shown below is displayed. 

 

 

(13) After the connection has been established, operations on the High-performance Embedded Workshop 
screen become possible. 

  

Once the E200F emulator is successfully connected, [Connected] is displayed on the [Debug] tabbed 
page of the [Output] pane. 
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4.3 Analyzing Performance by Using Eventpoints 
This section introduces two methods of performance analysis: measurement from the start of execution to 

a break and measurement over a specific period. 

(1) To load a program, double-click on a load-module file (.abs) that has been registered in the workspace. 

              

Completion of loading is 
indicated by a downward 
arrow on the file icon. 

Double-click 

 

(2) Double-click on the source file name "tutorial.cpp" in the workspace to open the source code in the 
[Source] pane. 
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(3) Select [Performance Analysis] from the [Performance] item of the [View] menu. 

 

 

(4) The [Select Performance Analysis Type] dialog box will appear. Select [Onchip Performance] and click 
on [OK]. 
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(5) The [Performance Analysis] pane will appear. 
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(6) Select [Eventpoints] from the [Code] item of the [View] menu. 
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(7) The [Event] pane is opened. Select the [Onchip Event] tab. Then right-click on a desired condition and 
select [Combination action(Sequential or PtoP)] from the popup menu. 
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(8) The [Combination action(Sequential or PtoP)] dialog box will appear. Select [Don’t care] for [Ch1,2,3] 
and click on [OK]. 

 

   [Don’t care]: Combinations of actions are not used as conditions. 
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(9) Right-click on the [Performance Analysis] pane and select [Set…] from the popup menu. 
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(10) The [Performance Analysis] dialog box opens. Select [Elapsed time] for [Channel 1]. 

 

Right-click 

The following options are selectable in the [Performance Analysis] dialog box. 

- Disabled (no option): Disables any setting 

- Elapsed time (AC): Number of cycles (Iφ) executed 

- Number of execution states (VS): Number of execution states 

- Branch instruction count (BT): Number of branch instructions 

- Number of execution instructions (I): Number of executed instructions, including repeated execution 

- Exception/interrupt counts (EA): Number of exceptions and interrupts 

- Interrupt counts (INT): Number of interrupts 

- URAM area access counts (UN): Numbers of times the URAM area was accessed for instructions and data 

- URAM area instruction access counts (UIN): Number of times the URAM area was accessed for instructions 

- URAM area data access counts (UDN): Number of times the URAM area was accessed for data 
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(11) Make settings for [Channel 2] to [Channel 4] as shown below and click on [OK]. 

 

 

(12) The settings are shown in the [Performance Analysis] pane. 
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(13) Double-click on the first line of function main (line 28) in the source file “tutorial.cpp” to set an on-chip 
breakpoint. 
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(14) After setting the on-chip breakpoint, select [Reset Go] from the [Debug] menu to execute the program. 

  

Double-click on the 
first line of function 
main.
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(15) The program stops at the line where the on-chip breakpoint has been set and the [Performance 
Analysis] pane shows the result of performance analysis. The comment “EVENT CONDITION for L bus” 
is displayed in the [Output] pane. 

  

Now the performance from the reset routine to function main is displayed. 

【Result of performance analysis】 

- AC (number of cycles (Iφ) executed):  D’17069 (H’000042AD) 

  Elapsed time = Number of cycles (Iφ) executed x CPU clock period (Iφ) 

        = 17,069 x (1/10 MHz) 

= 1,707 μs 

（For details on setting of the CPU clock frequency, refer to step (10) of section 4.2.） 

- VS (number of execution states): D’1155 (H’00000483) 

- BT (number of branch instructions): D’559 (H’0000022F) 

- I (number of executed instructions): D’1146 (H’0000047A) 
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(16) Delete condition BC1 from the [Onchip Event] column. 

  

If BC2 has also been set, delete it too. 
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(17) Double-click on line 45 and then line 48. After that, click on the [Event] tab. 

 

Double-click on line 45 
and then line 48.
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(18) Right-click on a desired condition in the [Event] pane to open the popup menu, and select [Combination 
action(Sequential or PtoP)]. 

 

 

(19) The [Combination action(Sequential or PtoP)] dialog box will appear. Select [Ch 1 to Ch 2 PA] for 
[Ch1,2,3] and click on [OK]. 

 

   [Ch 1 to Ch 2 PA]: After event condition 1 (start condition) is satisfied, the emulator measures the 
performance until event condition 2 (end condition) is satisfied. 

   [Ch 2 to Ch 1 PA]: After event condition 2 (start condition) is satisfied, the emulator measures the 
performance until event condition 1 (end condition) is satisfied. 
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(20) The [Event] pane shows the settings that have been made. 
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(21) Select the [tutorial.cpp] tab. Right-click on line 52 and select [Add] for BC10. 

 

Click on line 52 and select 
[Add] for BC10. 
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(22) Clear the result of performance analysis in the [Performance Analysis] pane and then execute the 
program. 

 

Clear the existing results 
before clicking on the [Go] 
button. 

Click on this button to clear 
the existing results. 
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(23) The program stops at line 52, where the breakpoint has been set, and the [Performance Analysis] pane 
shows the results of performance analysis. The [Output] pane shows the comment “EVENT CONDITION 
10”. 

 

The performance from line 45 to 48, from which the functions sort and change are called, in that order, 
has been analyzed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

REJ06J0043-0100/Rev.1.00 2008.3 Page 22 of 30 



 SH7080-Series E200F Emulator 
Performance Measurement 

4.4 Analyzing Performance by Setting Data Conditions (Eventpoints) 
This section gives examples of setting data conditions. 

(1) In this example, the condition is the writing of a particular value (32 bits: H’00001234) into a variable (at 
FFFFA000 in RAM). Double-clicking on the [Ch1] column in the [Event] pane opens the [Event condition 
1] dialog box. Click on the [Address] tab and specify H’FFFFA000 as [Address]. 
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Click on the [Data] tab. Remove the tick from the [Don’t Care] checkbox and specify H’00001234 as 
[Value]. 

 

 

Click on the [Bus State] tab. Select [L-Bus(CPU)] as [Bus type] and [Write] for [Read/Write], and then 
click on [OK]. 
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(2) In the next example, the condition is the writing of a particular value (H’000055AA) into another variable 
(at FFFFA100 in RAM). Double-clicking on the [Ch2] column in the [Event] pane opens the [Event 
condition 2] dialog box. Click on the [Address] tab and specify H’FFFFA100 as [Address]. 

 

 

Click on the [Data] tab. Specify H’000055AA as [Value]. 

 

 

Click on the [Bus State] tab. Select [L-Bus(CPU)] as [Bus type] and [Write] for [Read/Write], and then 
click on [OK]. 
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(3) The [Performance Analysis] pane shows the settings that have been made. 

 

As is shown in the picture above, the performance analysis can also be done in the order [Ch 2 to Ch 1 
PA]. 

 

4.5 Analyzing Performance by Measuring the Number of Executed Instructions 
This section introduces how to specify [Number of execution instructions (I)] as the condition for a single 

assembly instruction. Here, this is used to measure the number of times a given instruction is passed. 

(1)  View the source file “tutorial.cpp” in mixed mode and double-click on the [Onchip Event] column 
between lines 48 and 49 to set an on-chip breakpoint. 

 

Double-click 

By specifying the first address of an instruction that is not a branch or delayed-slot instruction and the 
address of the following instruction as the condition, you will be able to view, in the [Result] column, the 
number of times this range has been passed. If you set a condition of this type in an interrupt handling 
routine, for example, it is possible to view the number of times a specific function is called. 

Note, however, that the number measured may not be correct if the target instruction is in an area 
where interrupts are enabled or the instruction may generate an exception. 
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(2) The [Event] pane shows the settings that have been made. 

 

Specify the address range from H’00001062 to H’00001064 as the condition. 

 

(3) After the program has been run, the [Performance Analysis] pane displays the results of analysis. The 
[Result] column for Ch4 ([I] condition) shows the number of times the instruction was executed. 

 

In the screenshot above, the result is H’7181 (D’29057), which means address H’00001062 has been 
passed 29,057 times. 

 

We conclude the description of performance analysis here. 
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5. Frequently Asked Questions 

5.1 Can you provide any notes on analyzing performance? 
(1) Use of the profiling and on-chip performance analysis functions at the same time is not possible. The 

[Can not use this function] error-message dialog box will be displayed if simultaneous use is attempted. 

(2) Do not change the setting for performance analysis using channels 1 and 2 ([Ch 1 to Ch 2 PA] or [Ch 2 
to Ch 1 PA] in the [Ch1,2,3] list of the [Combination action(Sequential or PtoP)] dialog box) on the 
[Onchip Event] tabbed page while the user program is running. Changing the settings in this way will 
lead to incorrect performance analysis. 

(3) If the start condition is satisfied after the end condition has been satisfied, performance analysis will be 
resumed. The result shown at a break will be the sum of all results measured during the period of 
performance analysis. 

(4) When you use the measurement start/end conditions ([Ch 1 to Ch 2 PA] or [Ch 2 to Ch 1 PA]), the 
value in the [Count] page of the [Event condition 1] dialog box must be specified as one. 

(5) If there is a conflict between a DMA or DTC transfer and satisfaction of an event condition (including an 
external-bus access condition), this may prevent the triggering of a break, stopping or acquisition of 
internal trace information, or starting or stopping of performance analysis by the event condition. 

(6) In debugging of the SH7125/SH7124 without the EV-chip unit connected to the emulator, the 
performance analysis function is not supported. That is, this function is only supported when the 
EV-chip unit is connected to the emulator. 
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6. Related Documents 
The E200F emulator and High-performance Embedded Workshop provide many other useful functions not 

mentioned in this document. Please refer to the following related documents for important information such 
as detailed specifications, technical information, or restrictions on each product. 

 

【Documents Related to the E200F Emulator】 

・ SH-2A, SH-2 E200F Emulator User's Manual 

・ Limitations on SH-2A, SH-2 E200F Emulator 

・ SH-2A, SH-2 E200F Emulator Additional Document for User's Manual 

(Supplementary Information on Using the SH7086) 

 

【Documents Related to High-Performance Embedded Workshop】 

・ High-performance Embedded Workshop User's Manual 

・ High-performance Embedded Workshop Release Note 

 

 

【Documents Related to MCU】 

・ SH7080 Group Hardware Manual 

・ SH-2A, SH2A-FPU Software Manual 

 

 

【Document Related to SuperH™ Family C/C++ Compiler Package】 

・ SuperH™ RISC engine C/C++ Compiler, Assembler, Optimizing Linkage Editor Compiler Package 
User's Manual 

・ SuperH™ RISC engine C/C++ Compiler Package Application Note 

 

 
Visit the following Renesas websites for information on this product: 

Global site:  http://www.renesas.com/e200f

Japanese site: http://japan.renesas.com/e200f

 

http://www.renesas.com/e200f
http://japan.renesas.com/e200f
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Renesas Website and Customer Support 
Renesas Technology Website: 

http://www.renesas.com/
 

Customer Support: 
http://www.renesas.com/inquiry
csc@renesas.com
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1. This document is provided for reference purposes only so that Renesas customers may select the appropriate Renesas 
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